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Working with Events

MWTM enables you to view information about all discovered events, including their associated network 
objects and other information.

This chapter includes the following information:

• Viewing Basic Information for All Events, page 5-1

• Viewing Events for a Specific Object, page 5-7

• Viewing Detailed Information for an Event, page 5-7

• Setting an Event Filter, page 5-8

• Loading an Existing Event Filter, page 5-12

• Saving an Event Filter File, page 5-13

• Viewing Event Properties, page 5-15

• Attaching a Note to an Event, page 5-16

• Viewing Notes for an Event, page 5-17

• Changing the Way MWTM Processes Events, page 5-17

• Forwarding Events as Traps to Other Hosts, page 5-35

• Setting Sounds for Events at an MWTM Client, page 5-36

Related Topics:

• Changing MWTM Client Preference Settings, page 11-2

• Viewing the Topology of the Network, page 8-1

• Working with Nodes, page 6-1

Viewing Basic Information for All Events
To view basic information for all events, select Events in the left pane of the MWTM Main Window. 
MWTM displays the Event Window.

The Event Window displays information about the events delivered by the MWTM event logger and 
event processor for all objects in the current network view.
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Note You can display more than one Event Window at one time. This enables you to view multiple Event 
Windows at the same time, with different event filtering in each window or dialog.

The Event Window is composed of the following sections:

• Event Toolbar Buttons, page 5-2

• Right-Click Menu for All Events, page 5-3

• Right-Click Menu for a Specific Event, page 5-3

• Event Table, page 5-5

Event Toolbar Buttons
The Event Window provides the following toolbar buttons:

Button Description

Set Filter Opens the Event Filter dialog.

Apply Filter

or

Remove Filter

Activates and deactivates the event filter specified in the Event Filter 
dialog:

• If the filter is activated, MWTM displays only those events that 
pass the filter.

• If the filter is deactivated, MWTM displays all events.

• If you activate a filter in an object’s Recent Events table in the 
MWTM Main Window, the filter is activated in all Recent Events 
tables in the MWTM Main Window for all other objects. The 
filter is not activated in Recent Events tables in Show In New 
Window windows or Real-Time Data and Charts windows.

Pause

or

Resume

Pauses or resumes the table.

While the table is paused, MWTM does not display new events in the 
table (unless you apply an event filter or edit your event preferences). 
When the table is resumed, all new events since the table was paused 
are added to the display.

If events are deleted while the table is paused, they are not removed 
from the table. Instead, they are grayed-out and cannot be 
acknowledged or edited. Deleted events are removed from the table 
when you resume the table.

Acknowledge Makes the selected event or events acknowledged.

Unacknowledge Makes the selected event or events unacknowledged.

Event Properties Opens the Event Properties window.

Edit Notes Opens the Edit Event Dialog.
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Right-Click Menu for All Events
To see the right-click menu for all events, select Events in the left pane and click the right mouse button. 
The events right-click menu provides the following options:

Right-Click Menu for a Specific Event
The Event Window provides a subset of the MWTM Main Menu as a right-click menu. To see this menu, 
select an event and click the right mouse button. The event right-click menu provides the following 
options:

Time Difference Displays the difference in days, minutes, hours, and seconds between 
two events.

Find Finds specific text in the event table.

Create Sound Filter Opens the Event Sound Filters dialog and the Event Sound Filters List 
dialog, with fields populated based on the selected event.

Adjust Row Height Adjusts the table row height and wraps the message text as follows:

• Click once to double the row height and wrap the message text.

• Click again to triple the row height and wrap the message text.

• Click again for single row height and no message text wrapping. 
This is the default setting.

This setting is saved automatically with your preferences.

Help for Event Displays context-sensitive help for the selected event in a separate 
Web browser.

Button Description

Menu Command Description

Show In New Window Opens the Event Window in a new window.

Sort Tree By Status Sorts the entire tree in the left pane by the status of each object.

Sort Tree By Name Sorts the entire tree in the left pane by the name of each object.

Back > List of Windows Navigates back to a window viewed in this session.

MWTM maintains a list of up to 10 Back windows.

Forward > List of 
Windows

Navigates forward to a window viewed in this session.

MWTM maintains a list of up to 10 Forward windows.
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Menu Command Description

Edit Notes Opens the Edit Event Dialog for the selected event.

Go To > Object Displays the Node Window for the node or Interface 
Window for the interface associated with the selected 
event.

If there is no object associated with the event, this option is 
not displayed.

View > Configuration Details Displays the Details window for the object associated with 
the selected event.

View > Notes Displays the Event Notes dialog for the selected event.

If there are no notes associated with this event, this option 
is grayed-out.

View > Center in Topo Opens the Topology Window, with the display zoomed to 
center on the object associated with the selected event.

If more than one view contains the object associated with 
the selected event, MWTM prompts you to choose one of 
the views.

Event History > Status Change 
Messages

Displays the MWTM Network Status Log for Status 
Change Messages in a Web browser, with messages 
displayed for only the object associated with selected 
event.

Event History > SNMP Trap Messages Displays the MWTM Network Status Log for SNMP Trap 
Messages in a Web browser, with messages displayed for 
only the object associated with selected event.

Event History > Status and Trap 
Messages

Displays the MWTM Network Status Log for Status 
Change Messages and SNMP Trap Messages in a Web 
browser, with messages displayed for only the object 
associated with selected event.

Event History > Network Status 
Metrics

Displays the MWTM Network Status Log for Metrics in a 
Web browser, with metrics displayed for only the object 
associated with selected event.

Node Drill-Down > Show Syslog 
Messages

Displays the Node Details: Syslog table, which polls the 
node associated with the selected event and displays all 
messages in its system log.

This option is not available if the node is in Unknown or 
Unmanaged status.

Node Drill-Down > Show CPU 
Processes

Opens the Node Details: CPU Processes panel, which polls 
the node associated with the selected event for information 
about its CPU processes.

This option is not available if the node is in Unknown or 
Unmanaged status.
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Event Table
The event table displays information about events delivered by the MWTM event logger and event 
processor.

To see mouse over help popup for each column in the table, place the cursor over a column header.

If a cell is too small to show all of its data, place the cursor over the cell to see the full data in a mouse 
over help popup.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
MWTM displays all of the columns in the event table except Internal ID, Note, Message Name, Ack 
By, Ack Time, Node, and Router Interface.

• To display hidden columns, right-click in the table header and select the checkboxes for the columns 
you want to display.

• To hide columns, right-click in the table header and clear the checkboxes for the columns you want 
to hide.

See the “Resizing, Sorting, and Hiding Table Columns” section on page 3-30 for more information about 
resizing, sorting, displaying, or hiding columns.

To see detailed information about an event, right-click the event in a window, then select Event 
Properties in the right-click menu.

The event table contains the following columns:

Node Drill-Down > Show Trap 
Configuration

Opens the Node Details: Trap Configuration panel, which 
displays all trap settings for the node, as well as all hosts 
and port numbers to which the node sends traps.

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level 
System Administrator (Level 5).

This option is not available if the node is in Unknown or 
Unmanaged status.

Acknowledge Makes the event acknowledged, which means that it has 
been received and processed.

Unacknowledge Makes a previously acknowledged event unacknowledged.

Event Properties Opens the Event Properties window.

Create Sound Filter Opens the Event Sound Filters dialog and the Event Sound 
Filters List dialog, with fields populated based on the 
selected event.

Help for Event Displays context-sensitive help for the selected event in a 
separate Web browser.

Menu Command Description
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Column Description

Internal ID Internal ID of the event. The internal ID is a unique ID for every object, assigned by 
MWTM for its own internal use. It can also be useful when the TAC is debugging 
problems.

Ack Indicates whether the event has been acknowledged:

• To acknowledge an unacknowledged event, use the Acknowledge toolbar button.

• To make a previously acknowledged event unacknowledged, use the 
Unacknowledge toolbar button.

Category Type of the event. Default values are:

• Create—Creation event, such as the creation of a seed file.

• Delete—Deletion event, such as the deletion of an object or file.

• Discover—Discovery event, such as Discovery beginning.

• Edit—Edit event. A user has edited an object.

• Ignore—Ignore event. A user has Ignored a link or linkset.

• Login—Login event. A user has logged in to MWTM.

• LoginDisable—LoginDisable event. MWTM has disabled a user’s User-Based 
Access authentication as a result of too many failed attempts to log in to MWTM.

• LoginFail—LoginFail event. An attempt by a user to log in to MWTM has failed.

• Logout—Logout event. A user has logged out of MWTM.

• OverWrite—OverWrite event. An existing file, such as a seed file or route file, 
has been overwritten.

• Poll—Poll event, such as an SNMP poll.

• Purge—Purge event. A user has requested Discovery with Delete Existing Data 
selected, and MWTM has deleted the existing MWTM database.

• Status—Status change message generated.

• Trap—SNMP trap message generated.

You can customize this field. See the “Changing Event Categories” section on 
page 5-23 for more information.

Severity Severity of the event. Default values are:

• Critical—The default color is red.

• Indeterminate—The default color is aqua.

• Informational—The default color is white.

• Major—The default color is orange.

• Minor—The default color is yellow.

• Normal—The default color is green.

• Warning—The default color is blue.

You can customize this field. See the “Changing Event Severities and Colors” section 
on page 5-24 for more information.

Note Indicates whether there is a note associated with the event.
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Viewing Events for a Specific Object
MWTM enables you to view events for only a selected object. To do so, right-click an object in a window, 
then select View > Events from the right-click menu. MWTM displays recent events for the selected 
object. For more information, see the following sections:

• Node Details: Recent Events, page 6-38

• View Details: Recent Events, page 4-19

Viewing Detailed Information for an Event
MWTM enables you to view detailed configuration information for the object associated with a specific 
event.

To display detailed information for an event, select Events in the left pane of the MWTM Main Window, 
right-click an event in a window, then select View > Configuration Details in the right-click menu. 
MWTM displays detailed information for the selected object. For more information, see the following 
sections:

• Viewing Detailed Information for a Node, page 6-10

• Viewing Detailed Information for a View, page 4-9

Message 
Name

User-specified message name for the event, used by MWTM for trap forwarding. The 
default message name is MWTM.

For more information about user-specified message names and trap forwarding, see 
the “Forwarding Events as Traps to Other Hosts” section on page 5-35.

Time Date and time the event was logged.

Ack By If you have not implemented MWTM User-Based Access, name of the device that last 
acknowledged the event.

If you have implemented MWTM User-Based Access, name of the user who last 
acknowledged the event.

If no one has acknowledged the event, this field is blank.

Ack Time Date and time the event was last acknowledged or unacknowledged.

Node Name of the node associated with the event. If there is no node associated with the 
event, None is displayed.

Message Message associated with the event.

You can customize this field. See the “Changing the Way MWTM Processes Events” 
section on page 5-17 for more information.

Router 
Interface

Name of the router interface associated with the event. If there is no router interface 
associated with the event, None is displayed.

Column Description
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Setting an Event Filter
MWTM enables you to change the way it presents event information.

To change the way MWTM presents event information, select the Set Filter button at the top of the Event 
Window. MWTM displays the Event Filter dialog with the Properties tab selected.

The Event Filter dialog is composed of the following sections:

• Event Filter Buttons, page 5-8

• Properties Settings, page 5-8

• Selected Objects Settings, page 5-11

Related Topics:

• Loading an Existing Event Filter, page 5-12

• Saving an Event Filter File, page 5-13

• Viewing Event Properties, page 5-15

Event Filter Buttons
The Event Filter dialog contains the following buttons:

Properties Settings
The Properties settings in the Event Filter dialog enable you to specify the types of event MWTM is to 
display in the Event Window, including the category and severity of event, whether the event is 
acknowledged, and other properties.

To display the Properties settings, select the Properties tab in the Event Filter dialog.

The Properties settings contain the following sections:

• Categories, page 5-9

• Severities, page 5-10

Button Description

OK Applies any changes you made to the event filter and closes the Event Filter dialog.

Load Opens the Load File Dialog: Load Filter, which enables you to load an already existing 
event filter file.

If you are viewing events for a specific object in the left pane of the MWTM Main 
Window, this button is not available.

Save Opens the Save File Dialog: Save Filter, which enables you to save the event filter file 
with a new name, or overwrite an existing event filter file.

If you are viewing events for a specific object in the left pane of the MWTM Main 
Window, this button is not available.

Cancel Closes the Event Filter dialog without applying any changes to the event filter.

Help Displays online help for the current dialog.
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• Other, page 5-10

Categories

Use the Categories section of the Properties settings to specify which event categories you want to 
display in the Event Window.

The Categories section contains the following default fields and buttons.

Note These are the default categories; there might be additional categories, as defined by the MWTM system 
administrator. For information about custom categories, see the “Changing Event Categories” section on 
page 5-23.

Field or Button Description

Status Checkbox used to indicate whether Status events are to be displayed in the Event 
Window. The default setting for this checkbox is selected.

Trap Checkbox used to indicate whether Trap events are to be displayed in the Event 
Window. The default setting for this checkbox is selected.

Create Checkbox used to indicate whether Create events are to be displayed in the Event 
Window. The default setting for this checkbox is selected.

Delete Checkbox used to indicate whether Delete events are to be displayed in the Event 
Window. The default setting for this checkbox is selected.

Discover Checkbox used to indicate whether Discover events are to be displayed in the Event 
Window. The default setting for this checkbox is selected.

Edit Checkbox used to indicate whether Edit events are to be displayed in the Event 
Window. The default setting for this checkbox is selected.

Ignore Checkbox used to indicate whether Ignore events are to be displayed in the Event 
Window. The default setting for this checkbox is selected.

Login Checkbox used to indicate whether Login events are to be displayed in the Event 
Window. The default setting for this checkbox is selected.

LoginDisable Checkbox used to indicate whether LoginDisable events are to be displayed in the 
Event Window. The default setting for this checkbox is selected.

LoginFail Checkbox used to indicate whether LoginFail events are to be displayed in the 
Event Window. The default setting for this checkbox is selected.

Logout Checkbox used to indicate whether Logout events are to be displayed in the Event 
Window. The default setting for this checkbox is selected.

OverWrite Checkbox used to indicate whether OverWrite events are to be displayed in the 
Event Window. The default setting for this checkbox is selected.

Poll Checkbox used to indicate whether Poll events are to be displayed in the Event 
Window. The default setting for this checkbox is selected.

Purge Checkbox used to indicate whether Purge events are to be displayed in the Event 
Window. The default setting for this checkbox is selected.

Select All Selects all event category checkboxes.

Deselect All Clears all event category checkboxes.
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Severities

Use the Severities section of the Properties settings to specify which event severities you want to display 
in the Event Window.

The Severities section contains the following default fields.

Note These are the default severities; there might be additional severities, as defined by the MWTM system 
administrator. For information about custom severities, see the “Changing Event Severities and Colors” 
section on page 5-24.

Other

Use the Other section of the Properties settings to further define the event filter for the Event Window. 
These settings are applied to all event displays in the current view.

The Other section contains the following fields:

Field Description

Informational Checkbox used to indicate whether events of severity Informational are to be 
displayed in the Event Window. The default setting for this checkbox is selected.

Normal Checkbox used to indicate whether events of severity Normal are to be displayed in 
the Event Window. The default setting for this checkbox is selected.

Indeterminate Checkbox used to indicate whether events of severity Indeterminate are to be 
displayed in the Event Window. The default setting for this checkbox is selected.

Warning Checkbox used to indicate whether events of severity Warning are to be displayed in 
the Event Window. The default setting for this checkbox is selected.

Critical Checkbox used to indicate whether events of severity Critical are to be displayed in 
the Event Window. The default setting for this checkbox is selected.

Minor Checkbox used to indicate whether events of severity Minor are to be displayed in the 
Event Window. The default setting for this checkbox is selected.

Major Checkbox used to indicate whether events of severity Major are to be displayed in the 
Event Window. The default setting for this checkbox is selected.

Field Description

Acknowledged Checkbox used to indicate whether only acknowledged events are to be 
displayed in the Event Window. The default setting for this checkbox is 
cleared.

Unacknowledged Checkbox used to indicate whether only unacknowledged events are to be 
displayed in the Event Window. The default setting for this checkbox is 
selected.

Time Before Checkbox used to indicate whether only events logged by MWTM prior to a 
specified date and time are to be displayed in the Event Window. The default 
setting for this checkbox is cleared.
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Selected Objects Settings
MWTM enables you to specify the object for which MWTM is to display events in the Event Window. 
To do so, select the Selected Objects tab in the Event Filter dialog. MWTM displays the Event Filter 
dialog with the Selected Objects tab highlighted.

Time Before Field Specifies the date and time prior to which events logged by MWTM are to be 
displayed in the Event Window. This field is grayed-out unless the Time 
Before checkbox is selected.

Time After Checkbox used to indicate whether only events logged by MWTM after a 
specified date and time are to be displayed in the Event Window. The default 
setting for this checkbox is cleared.

Time After Field Specifies the date and time after which events logged by MWTM are to be 
displayed in the Event Window. This field is grayed-out unless the Time After 
checkbox is selected.

Message Contains Checkbox used to indicate whether only events that contain the specified 
message text are to be displayed in the Event Window. The default setting for 
this checkbox is cleared.

Match Case Checkbox used to indicate whether only events that match the case of the text 
in the Message Contains field are to be displayed in the Event Window. This 
field is grayed-out unless the Message Contains checkbox is selected. If the 
Message Contains checkbox is selected, the default setting for this checkbox 
is cleared.

Field Description
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The Selected Objects settings contains the following fields and buttons:

Loading an Existing Event Filter
MWTM enables you to load a specific event filter file and change the list of event filter files.

To load an existing event filter, click Load in the Event Filter dialog. MWTM displays the Load File 
Dialog: Load Filter dialog.

The Load File Dialog: Load Filter contains the following fields and buttons:

Field or Button Description

Node Drop-down list box of all nodes that have been discovered by MWTM:

• If you want to filter events based on a node, select a node from the 
drop-down list box. The Rtr Interface drop-down list box appears.

• If you do not want to filter events based on a node, select None. MWTM 
grays-out the other object fields. This is the default setting.

Rtr Interface Drop-down list box of all interfaces associated with the selected router:

• If you want to filter events based on a router interface, select an interface 
from the drop-down list box.

• If you do not want to filter events based on a router interface, select None. 
This is the default setting.

Reset Restores Node to None, grays-out other object fields.

Selected Objects: 
Object Type

Indicates the type of object, if any, upon which the event filter is based.

Selected Objects: 
Node

Indicates the node, if any, upon which the event filter is based.

Selected Objects: 
Rtr Interface

Indicates the router interface, if any, upon which the event filter is based.

Field or Button Description

Type Icon indicating whether the item in the table is a file or a folder.

Name Name of the event filter file or folder.

Last Modified Date and time the event filter file or folder was last modified.

Size (bytes) Size of the event filter file or folder, in bytes.

Number of Files
(displayed in bottom left corner)

Total number of event filter files and folders.

OK Loads the selected event filter, saves any changes you made to the 
list of files, and closes the dialog.

To load an event filter file, double-click it in the list, select it in 
the list and click OK, or enter the name of the file and click OK. 
MWTM loads the event filter file, saves any changes you made to 
the list of files, closes the Load File Dialog: Load Filter dialog, 
and returns to the Event Filter dialog.
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Saving an Event Filter File
MWTM enables you to save a specific event filter file and change the list of event filter files.

When you are satisfied with the filter settings, click Save in the Event Filter dialog. MWTM displays the 
Save File Dialog: Save Filter dialog.

The Save File Dialog: Save Filter contains the following fields and buttons:

Delete Deletes the selected file from the event filter file list. MWTM 
issues an informational message containing the name and location 
of the deleted file.

Cancel Closes the dialog without loading an event filter file or saving any 
changes to the event filter file list.

Help Displays online help for the dialog.

Field or Button Description

Field or Button Description

Type Icon indicating whether the item in the table is a file or a folder.

Name Name of the event filter file or folder.

Last Modified Date and time the event filter file or folder was last modified.

Size (bytes) Size of the event filter file or folder, in bytes.

Filename Name by which you want to save the event filter file.

If you create a new event filter file name, you can use any letters, 
numbers, or characters in the name that are allowed by your 
operating system. However, if you include any spaces in the new 
name, MWTM converts those spaces to dashes. For example, 
MWTM saves file “a b c” as “a-b-c”.

Number of Files
(displayed in bottom left corner)

Total number of event filter files and folders.

OK Saves any changes you made to the current event filter file and 
closes the dialog.

To save the event filter file with a new name, use one of the 
following procedures:

• To save the file with a completely new name, enter the new 
name and click OK.

• To save the file with an existing name, overwriting an old 
event filter file, select the name in the list and click OK.

MWTM saves the event filter file with the new name, saves any 
changes you made to the list of files, closes the Save File Dialog: 
Save Filter dialog, and returns to the Event Filter dialog.

Delete Deletes the selected file from the event filter file list. MWTM 
issues an informational message containing the name and location 
of the deleted file.
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Cancel Closes the dialog without saving the event filter file or saving any 
changes to the event filter file list.

Help Displays online help for the dialog.

Field or Button Description
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Viewing Event Properties
MWTM enables you to view detailed information about a selected event, including its associated object, 
status, and other information.

To view detailed information about an event, right-click the event in a window, then select Event 
Properties in the right-click menu.

MWTM displays the Event Properties Dialog.

The Event Properties dialog contains the following tabs, fields, and button:

Tab, Field, or Button Description

Properties Tab Displays detailed information about the selected event.

Message Message text for the event.

You can customize this field. See the “Changing the Way MWTM Processes 
Events” section on page 5-17 for more information.

Category Type of the event. Default values are:

• Create—Creation event, such as the creation of a seed file.

• Delete—Deletion event, such as the deletion of an object or file.

• Discover—Discovery event, such as Discovery beginning.

• Edit—Edit event. A user has edited an object.

• Ignore—Ignore event. A user has Ignored a link or linkset.

• Login—Login event. A user has logged in to MWTM.

• LoginDisable—LoginDisable event. MWTM has disabled a user’s 
User-Based Access authentication as a result of too many failed attempts 
to log in to MWTM.

• LoginFail—LoginFail event. An attempt by a user to log in to MWTM has 
failed.

• Logout—Logout event. A user has logged out of MWTM.

• OverWrite—OverWrite event. An existing file, such as a seed file or route 
file, has been overwritten.

• Poll—Poll event, such as an SNMP poll.

• Purge—Purge event. A user has requested Discovery with Delete 
Existing Data selected, and MWTM has deleted the existing MWTM 
database.

• Status—Status change message generated.

• Trap—SNMP trap message generated.

You can customize this field. See the “Changing Event Categories” section on 
page 5-23 for more information.
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Related Topic:

• Viewing Basic Information for All Events, page 5-1

Attaching a Note to an Event
MWTM enables you to annotate an event, attaching a descriptive string to the event.

To annotate an event, right-click an event in the Event Window, then select Edit Notes in the right-click 
menu.

MWTM displays the Edit Event Dialog.

The Edit Event Dialog contains the following fields and buttons:

Severity Severity of the event. Default values are:

• Critical—The default color is red.

• Indeterminate—The default color is aqua.

• Informational—The default color is white.

• Major—The default color is orange.

• Minor—The default color is yellow.

• Normal—The default color is green.

• Warning—The default color is blue.

You can customize this field. See the “Changing Event Severities and Colors” 
section on page 5-24 for more information.

Timestamp Date and time the event was logged.

Message Name User-specified message name for the event, used by MWTM for trap 
forwarding. The default message name is MWTM.

For more information about user-specified message names and trap 
forwarding, see the “Forwarding Events as Traps to Other Hosts” section on 
page 5-35.

Acknowledged Indicates whether the event has been acknowledged.

Acknowledged By Name of the device that last acknowledged the event. If no one has 
acknowledged the event, this field is blank.

Ack Timestamp Date and time the event was last acknowledged or unacknowledged.

Node Name of the node associated with the event. If there is no node associated with 
the event, None is displayed.

Notes Tab Displays notes associated with this event.

Last Update Date and time the Notes field for this event was last updated. If there is no note 
currently associated with this event, this field displays the value Not Set.

Notes Notes associated with this event. If there is no note currently associated with 
this event, this field displays the value No Notes.

Close Closes the Event Properties dialog.

Tab, Field, or Button Description
5-16
Cisco Mobile Wireless Transport Manager User Guide 5.0

OL-7637-02



 

Chapter 5      Working with Events
  Viewing Notes for an Event
Related Topics:

• Viewing Basic Information for All Events, page 5-1

• Viewing Event Properties, page 5-15

• Viewing Notes for an Event, page 5-17

Viewing Notes for an Event
MWTM enables you to view the notes that have been associated with an event.

To view a note, right-click an event in a window, then select View > Notes in the right-click menu. (The 
Notes option is grayed-out if there is no note associated with the selected event.)

MWTM displays the Event Notes dialog.

The Event Notes dialog contains the following fields and button:

Related Topics:

• Attaching a Note to an Event, page 5-16

Changing the Way MWTM Processes Events
There are three main types of events in MWTM:

• Trap events, which are incoming events that are not solicited by MWTM.

Field or Button Description

Name Message text of the event.

Last Update Date and time the Notes field for this event was last updated. If there is no note 
currently associated with this event, this field displays the value Not Set.

You cannot edit this field.

Notes Notes to associate with this event. In this field, you can enter any important 
information about the event, such as its associated object, what triggered the event, 
how often it has occurred, and so on.

Save Saves changes you have made to the event information and exits the Edit Event 
Dialog.

Cancel Exits the Edit Event Dialog without saving any changes.

Help Displays online help for the current window.

Field or Button Description

Name Message text of the event.

Last Updated Date and time the Notes field for this event was last updated.

Notes Notes associated with this event.

OK Closes the Event Notes dialog.
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• Status events, which are status changes detected by MWTM.

• User Action events, which are events triggered by user actions.

Within those broad types, there are many subordinate types of events, each with a default category, 
severity, color, message text, and event help file. MWTM enables you to change the default 
characteristics of each type of event, tailoring them to meet your needs.

Note Changes you make to MWTM event processing can adversely affect your operating environment. In 
most environments, MWTM recommends that you use the default event processing settings without 
modification.

To change MWTM event processing, use one of the following procedures:

• Select Tools > Event Configurator from the MWTM Main Menu.

• Select Start > Programs > Cisco MWTM Client > Launch MWTM Event Configurator in 
Windows.

• Enter the mwtm eventeditor command. See the “mwtm eventeditor” section on page C-20 for more 
information.

MWTM launches the MWTM Event Configurator.

The Event Configurator enables you to customize the displayed category, severity, color, and message 
associated with events; and load, save, and deploy customized event configurations. You can also specify 
a list of SNMP server to which MWTM is to forward events in the form of traps.

The high-level MWTM event processing settings are displayed in the left pane of the MWTM Event 
Configurator window. The detailed settings for each high-level setting are displayed in the right pane.

The MWTM Event Configurator menu provides the following options:

Menu Command Description

File > Load Draft Loads the local copy of the event configuration that you saved.

File > Save Draft
(Ctrl-S)

Saves a local copy of the event configuration, including any changes you 
made using the Event Configurator. You can save only one local copy of the 
event configuration. You cannot specify a file name for the local copy.

File > Load Default Loads the default event configuration on this MWTM client.

The default event configuration is the standard event configuration used by 
MWTM when it is first installed. The default event configuration stored on 
the MWTM server and shared by all MWTM clients, but it cannot be modified 
by the clients.

File > Load Running Loads the event configuration that is currently running on the MWTM server.

File > Load Backup Loads the backup event configuration from the MWTM server.

MWTM creates a backup event configuration every time the event 
configuration on the MWTM server is overwritten.

File > Revert Reverts to the last event configuration that was loaded on the MWTM client. 
This could be the draft, default, running, or backup event configuration.
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This section provides the following information:

• Changing Event Limits, page 5-20

• Specifying a List of SNMP Servers for Trap Forwarding, page 5-22

• Changing Event Categories, page 5-23

• Changing Event Severities and Colors, page 5-24

• Changing Trap Events, page 5-25

• Changing Status Alarm Events, page 5-29

• Changing User Action Events, page 5-32

File > Deploy Deploys the event configuration that is currently being edited on this MWTM 
client to the MWTM server.

The deployed event configuration does not take effect until you restart the 
MWTM server. When you restart the MWTM server, MWTM automatically 
reflects your changes to the event configuration on the MWTM server and on 
all MWTM clients that connect to that server, and reflects any new or changed 
categories, severities, and other event characteristics in its Web display 
navigation bars.

File > Exit Closes the Event Configurator window. If you have made any changes to the 
event configuration, MWTM asks if you want to save the changes before 
leaving the window:

• Click Save Draft to save the changes in a local copy of the event 
configuration. You can save only one local copy of the event 
configuration. You cannot specify a file name for the local copy.

• Click Deploy to deploy the event configuration, including any changes 
you made, to the MWTM server.

The deployed event configuration does not take effect until you restart 
the MWTM server. When you restart the MWTM server, MWTM 
automatically reflects your changes to the event configuration on the 
MWTM server and on all MWTM clients that connect to that server, and 
reflects any new or changed categories, severities, and other event 
characteristics in its Web display navigation bars.

• Click No or Cancel to close the prompt window and return to the Event 
Configurator window.

Help > Topics
(F1)

Displays the table of contents for the MWTM online help.

Help > Window
(Shift-F1)

Displays online help for the current window.

Help > About
(F3)

Displays build date, version, SSL support, and copyright information about 
the MWTM application.

Menu Command Description
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Changing Event Limits
To change limits for the MWTM event database, select the turner beside Event Configuration, then 
click Limits in the left pane. MWTM displays the Limits Configuration window in the right pane, which 
contains the following fields:

Field Description

MaxEventDbRecords Sets the maximum number of events the MWTM event database can 
hold.

By default, the MWTM event database can hold a maximum of 5000 
events. If the database exceeds 5000 events, MWTM deletes the oldest 
events until the database is reduced to 5000 events.

To change the size of the MWTM event database, enter the new size, 
in number of events, in this field. The valid range is 0 events (that is, 
no limit) to an unlimited number of events. The default setting is 
5000 events.

Note As you increase the size of the event database, the 
performance of the MWTM server and clients is impacted.

MaxEventTimeToLive Sets the maximum length of time, in days, MWTM is to retain an 
event in the database.

By default, the MWTM event database retains events a maximum of 
7 days. MWTM deletes events that are older than 7 days.

To change the maximum age for events, enter the new age, in days, in 
this field. The valid range is 0 days (events are purged at each 
maintenance interval) to an unlimited number of days. The default 
setting is 7 days.

CompressEventDbInterval Sets the length of time, in minutes, between maintenance checks of the 
database.

By default, MWTM performs maintenance on the event database 
every 60 minutes, deleting all events in excess of 5000 and all events 
older than 7 days.

To change the maintenance interval, enter the new interval, in minutes, 
in this field. The valid range is 0 minutes (perform continual 
maintenance; not advised) to an unlimited number of minutes. The 
default setting is 60 minutes.

Note The shorter the maintenance interval, the greater the impact on 
the performance of the MWTM server and clients.
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AutomationTimeout Sets the maximum length of time, in seconds, MWTM is to allow an 
event automation script to run.

By default, the MWTM event database allows an event automation 
script to run for 300 seconds (5 minutes) before canceling the script 
and moving on.

To change the event automation timeout interval, enter the new 
interval, in seconds, in this field. The valid range is 0 seconds (no 
automation) to an unlimited number of seconds. The default setting is 
300 seconds.

Note MWTM runs each automation script sequentially, not in 
parallel. Therefore, the longer the automation timeout 
interval, the greater the chance that a failed script can delay 
follow-on scripts.

ProcessUndiscovered Determines whether MWTM is to process events from undiscovered 
nodes:

• False—Do not process events from undiscovered nodes. This is 
the default setting.

• True—Begin processing events from undiscovered nodes.

Field Description
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Specifying a List of SNMP Servers for Trap Forwarding
MWTM enables you to specify a list of SNMP server, or hosts, to which MWTM is to forward events in 
the form of traps.

For more information about enabling MWTM trap forwarding, see the “Forwarding Events as Traps to 
Other Hosts” section on page 5-35.

To specify the list of hosts, select the turner beside Event Configuration, then click SNMP Servers in 
the left pane. MWTM displays the SNMP Servers Configuration window in the right pane, which 
contains the following fields and buttons:

Field or Button Description

Host Name of the host NMS device that is to receive traps from MWTM. The host 
must be IP-routable, and the name must be a valid IP address or DNS name.

Port Host port number to which MWTM is to forward traps.

Community SNMP community string that MWTM is to include in forwarded traps.

Version Trap version to forward. Valid values are 1 and 2c.

Trap Type Type of trap MWTM is to forward to this host. Valid trap types are:

• CISCO-SYSLOG: The CISCO-SYSLOG-MIB clogMessageGenerated 
trap.

• CISCO-EPM-NOTIFICATION: CISCO-EPM-NOTIFICATION-MIB 
ciscoEpmNotificationAlarm trap.

Add Adds a new host name to the bottom of the list. Type over the default values with 
the new values.

Delete Deletes the selected host name from the list.

Send a trap for all 
events

Selects the Send Traps checkbox for all MWTM events. Select this button if you 
want MWTM to forward all events to the list of hosts.

If you select this button, and then you clear even a single Send Traps checkbox 
for any event, MWTM clears this button.

This radio button is mutually exclusive with the Send a trap for no events 
button.

Send a trap for no 
events

Clears the Send Traps checkbox for all MWTM events. Select this button if you 
do not want MWTM to forward any events to the list of hosts. This is the default 
setting.

If you select this button, and then you select even a single Send Traps checkbox 
for any event, MWTM clears this button.

This radio button is mutually exclusive with the Send a trap for all events 
button.
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Changing Event Categories
To change categories for the MWTM event database, select the turner beside Event Configuration, then 
click Categories in the left pane. MWTM displays the Categories Configuration window in the right 
pane, which contains the following field and buttons:

Field or Button Description

Category Name Lists the names of the currently defined MWTM event categories.

By default, MWTM provides the following event categories:

• Status—Status change message generated.

• Trap—SNMP trap message generated.

• Create—Creation event, such as the creation of a seed file.

• Delete—Deletion event, such as the deletion of an object or file.

• Discover—Discovery event, such as Discovery beginning.

• Edit—Edit event. A user has edited an event, linkset, or node.

• Ignore—Ignore event. A user has Ignored a link or linkset.

• Login—Login event. A user has logged in to MWTM.

• LoginDisable—LoginDisable event. MWTM has disabled a user’s 
User-Based Access authentication as a result of too many failed attempts to 
log in to MWTM.

• LoginFail—LoginFail event. An attempt by a user to log in to MWTM has 
failed.

• Logout—Logout event. A user has logged out of MWTM.

• OverWrite—OverWrite event. An existing file, such as a seed file or route 
file, has been overwritten.

Category Name
(continued)

• Poll—Poll event, such as an SNMP poll.

• Purge—Purge event. A user has requested Discovery with Delete Existing 
Data selected, and MWTM has deleted the existing MWTM database.

To change the name of an existing event category, highlight the category name 
and type over it with the new name. For example, you could replace every 
occurrence of LoginFail with BadLogin.

Add Adds a new category name to the bottom of the list. Type over the default 
category name with the new name.

Delete Deletes the selected category name from the list.

If there are events in the MWTM database that use the deleted category name, 
MWTM displays the Entry Substitution Dialog, which enables you to select a 
new category name to use in place of the deleted category name. Either select an 
existing category name from the drop-down list box, or enter a new category 
name. If you enter a new category name, it is added to the Category Name field.
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Changing Event Severities and Colors
To change severities or colors for the MWTM event database, select the turner beside Event 
Configuration, then click Severities in the left pane. MWTM displays the Severities Configuration 
window in the right pane, which contains the following fields and buttons:

Field or Button Description

Severity Name Lists the names of the currently defined MWTM event severities.

By default, MWTM provides the following event severities:

• Informational

• Normal

• Indeterminate

• Warning

• Critical

• Minor

• Major

To change the name of an existing event severity, highlight the severity name and 
type over it with the new name. For example, you could replace every occurrence 
of Error with Problem.

Severity Color Lists the colors of the currently defined MWTM event severities.

By default, MWTM provides the following event colors:

• Informational—The default color is white.

• Normal—The default color is green.

• Indeterminate—The default color is aqua.

• Warning—The default color is blue.

• Critical—The default color is red.

• Minor—The default color is yellow.

• Major—The default color is orange.

To change the color associated with an existing severity, select the current color, 
then select a new color from the drop-down list box. For example, you can display 
Warning events in maroon instead of yellow.

Add Adds a new severity name to the bottom of the list. Type over the default severity 
name with the new name, then select a color from the drop-down list box. The 
default color is white.

Delete Deletes the selected severity name from the list.

If there are events in the MWTM database that use the deleted severity name, 
MWTM displays the Entry Substitution Dialog, which enables you to select a new 
severity name to use in place of the deleted severity name. Either select an existing 
severity name from the drop-down list box, or enter a new severity name. If you 
enter a new severity name, it is added to the Severity Name field.
5-24
Cisco Mobile Wireless Transport Manager User Guide 5.0

OL-7637-02



 

Chapter 5      Working with Events
  Changing the Way MWTM Processes Events
Changing Trap Events
Trap events are incoming events that are not solicited by MWTM.

To change traps for the MWTM event database, select the turner beside Event Configuration, then 
select the turner beside Traps. MWTM lists the currently defined traps in the left pane.

To add a trap, right-click Traps and select Add from the right-click menu. MWTM opens the Add Entry 
Dialog, which lists the traps that are supported by MWTM but not yet configured. If all traps are 
configured, the Add and Delete options in the right-click menu are grayed out. Select a trap and click 
Add. MWTM adds the selected trap to the list of configured traps in the left pane.

To list all events associated with a trap, select the turner beside the trap. MWTM lists the currently 
defined events for that trap in the left pane.

• To add an event to a trap, right-click the trap (or one of its existing events) and select Add from the 
right-click menu. MWTM adds a new event to the list of events for that trap and opens the Trap 
Event Configuration panel for the new event, which enables you to change all aspects of that event.

• To delete a trap from the list of configured traps, right-click the trap and select Delete from the 
right-click menu. MWTM deletes the selected trap from the list of configured traps in the left pane.

Move Up Moves the selected severity up in the list.

Move Down Moves the selected severity down in the list.

Field or Button Description
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• To delete an event from a trap, right-click the event and select Delete from the right-click menu. 
MWTM deletes the selected event from the list of events associated with the trap in the left pane.

• To change an event, select the event in the left pane. MWTM displays the Trap Event Configuration 
panel in the right pane, which enables you to change all aspects of that event.

The Trap Event Configuration panel contains the following fields and buttons:

Field or Button Description

Name Name of the trap. You cannot change this field.

Event Keys and 
Setting

Names of the event keys, such as RouteDestinationState, and their settings, 
such as False.

You cannot change the names of the event keys, but you can change their settings. 
To change an event key setting, select a new setting from the drop-down list box. 
For example, you can change the setting for RouteDestinationState from 
Accessible to Unknown.

Category Category of the trap event, such as Trap.

To change the category, select a new category from the drop-down list box. The 
default category for traps is Trap.

Severity Severity of the trap event, such as Normal.

To change the severity, select a new severity from the drop-down list box.

Note The order of the severities affects the sort order of the severities in 
MWTM client tables.

Message Name User-specified message name for the event, used by MWTM for trap forwarding.

If you want MWTM to forward this event in the form of a trap to another host, 
you can specify a new, more meaningful message name for the event. The new 
message name can be from 1 to 30 characters, and can contain any letters (upper- 
or lowercase), any numbers, and any special characters. If you do not specify a 
new message name, MWTM uses the default message name, MWTM.

For more information about trap forwarding, see the “Forwarding Events as 
Traps to Other Hosts” section on page 5-35.

Message Message text associated with the trap event.

To change the message text, type over the message text.

You can also insert variable text in the message. To do so, right-click in the 
message text area. MWTM displays a popup menu of the valid substitution 
variables for this event. To insert a variable in the text area, select it in the popup 
menu.
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Help File Help file associated with the trap.

By default, MWTM provides extensive type-specific help for traps. However, if 
you prefer to provide your own enterprise-specific instructions to operators in the 
help file, MWTM enables you to do so.

To change the help file, create a new HTML help file or change the default 
MWTM help file:

• If you installed MWTM in the default directory, /opt, then the default help 
files are in the /opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• If you installed MWTM in a different directory, then the default help 
directory and files are located in that directory.

If you use an MWTM help file as a basis for your help file, rename it when you 
save it; do not use the existing MWTM name. If you do so, then the next time you 
install MWTM, MWTM overwrites the file and you lose your changes.

When you have created your new help files, store them in the 
/opt/CSCOsgm/apache/share/htdocs/customHelp directory. This directory and 
its contents are preserved when you upgrade to a new MWTM release. If you do 
not store your new help files in the customHelp directory, the files are lost the 
next time you upgrade to a new MWTM release.

When you have created your new help files and stored them in the customHelp 
directory, enter the new help file path and file name in the Help File field.

After you deploy the new event settings and restart the MWTM server, whenever 
you display help for the trap, MWTM displays your new, custom help file.

Open Opens the help file associated with the trap.

To see the help file, click Open. MWTM displays context-sensitive help for the 
selected trap in a separate Web browser.

Action: Run Automation command or script for the trap event, to be executed by a UNIX 
process.

MWTM enables you to automate events. That is, you can configure MWTM to 
call a UNIX script to drive automatic paging or e-mail, for example, whenever 
MWTM logs an event for which you have defined an automation script.

To configure automation for an event, enter a Run line with the following format:

UNIXCommand EventParameters

where:

• UnixCommand specifies either a binary command name or a shell script.

• EventParameters are information from the event that MWTM sends to 
UnixCommand as parameters. The set of EventParameters is the same as the 
set of Message element parameters, and they are specified the same way.

After you deploy the new event settings and restart the MWTM server, the 
specified event causes the automation script to run.

Field or Button Description
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Action: Run
(continued)

When configuring automation for events, keep in mind the following 
considerations:

• Detailed information about event automation scripts, including the times 
they start and stop and any output produced by the scripts, is recorded in the 
MWTM system event automation log file. For more information, see the 
“Viewing the MWTM System Event Automation Log” section on 
page 13-40.

• MWTM event automation scripts run separately from all other MWTM 
processing.

• If MWTM logs more than one automated event in rapid succession, MWTM 
runs each automation script sequentially, not in parallel. MWTM spawns a 
new UNIX process for each script, and waits for it to complete before 
running the next script.

• By default, MWTM allows an event automation script to run for 300 seconds 
(5 minutes) before canceling the script and moving on to the next script. To 
change the maximum run-time for event automation scripts, see the 
“Changing Event Limits” section on page 5-20.

Action: Poll Checkbox indicating whether MWTM is to poll the associated nodes:

• If you want MWTM to poll the nodes, select the checkbox. 

• If you do not want MWTM to poll the nodes, clear the checkbox.

Action: Send Trap Checkbox indicating whether MWTM is to forward the event as a trap to other 
systems:

• If you want MWTM to forward the event, select the checkbox.

• If you do not want MWTM to forward the event, clear the checkbox. This is 
the default setting.

Errors Error messages associated with the trap. Correct all errors before deploying the 
new event configuration.

Field or Button Description
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Changing Status Alarm Events
Status alarm events are status changes detected by MWTM.

To change status alarms for the MWTM event database, select the turner beside Event Configuration, 
then select the turner beside Status Alarms. MWTM lists the currently defined status alarms in the left 
pane.

To add a status alarm, right-click Status Alarms and select Add from the right-click menu. MWTM 
opens the Add Entry Dialog, which lists the status alarms that are supported by MWTM but not yet 
configured. Select a status alarm and click Add. MWTM adds the selected status alarm to the list of 
configured status alarms in the left pane.To list all status settings associated with a status alarm, select 
the turner beside the status alarm. MWTM lists the currently defined status settings for that status alarm 
in the left pane.

• To add a status setting to a status alarm, right-click the status alarm (or one of its existing status 
settings) and select Add from the right-click menu. MWTM adds a new status setting to the list of 
status settings for that status alarm and opens the Status Event Configuration panel for the new status 
setting, which enables you to change all aspects of that status setting.

• To delete a status alarm from the list of configured status alarms, right-click the status alarm and 
select Delete from the right-click menu. MWTM deletes the selected status alarm from the list of 
configured status alarms in the left pane.

• To delete a status setting from a status alarm, right-click the status setting and select Delete from 
the right-click menu. MWTM deletes the selected status setting from the list of status settings 
associated with the status alarm in the left pane.

• To change a status setting, select the status setting in the left pane. MWTM displays the Status Event 
Configuration panel in the right pane, which enables you to change all aspects of that status setting.
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The Status Event Configuration panel contains the following fields and buttons:

Field or Button Description

Name Name of the status alarm, such as RtrInterfaceStateChanged. You cannot 
change this field.

Status Key and 
Setting

Name of the status key, such as RtrInterfaceState, and its setting, such as 
Active.

You cannot change the name of the status key, but you can change its setting. To 
change a status key, select a new key from the drop-down list box. For example, 
you can change the setting for RtrInterfaceState from Active to Down.

Category Category of the status alarm, such as Status.

To change the category, select a new category from the drop-down list box. The 
default category for status settings is Status.

Severity Severity of the status alarm, such as Normal.

To change the severity, select a new severity from the drop-down list box.

Message Name User-specified message name for the event, used by MWTM for trap forwarding.

If you want MWTM to forward this event in the form of a trap to another host, 
you can specify a new, more meaningful message name for the event. The new 
message name can be from 1 to 30 characters, and can contain any letters (upper- 
or lowercase), any numbers, and any special characters. If you do not specify a 
new message name, MWTM uses the default message name, MWTM.

For more information about trap forwarding, see the “Forwarding Events as 
Traps to Other Hosts” section on page 5-35.

Message Message text associated with the status alarm.

To change the message text, type over the message text.

You can also insert variable text in the message. To do so, right-click in the 
message text area. MWTM displays a popup menu of the valid substitution 
variables for this event. To insert a variable in the text area, select it in the popup 
menu.
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Help File Help file associated with the status alarm.

By default, MWTM provides extensive type-specific help for status alarms. 
However, if you prefer to provide your own enterprise-specific instructions to 
operators in the help file, MWTM enables you to do so.

To change the help file, create a new HTML help file or change the default 
MWTM help file:

• If you installed MWTM in the default directory, /opt, then the default help 
files are in the /opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• If you installed MWTM in a different directory, then the default help 
directory and files are located in that directory.

If you use an MWTM help file as a basis for your help file, rename it when you 
save it; do not use the existing MWTM name. If you do so, then the next time you 
install MWTM, MWTM overwrites the file and you lose your changes.

When you have created your new help files, store them in the 
/opt/CSCOsgm/apache/share/htdocs/customHelp directory. This directory and 
its contents are preserved when you upgrade to a new MWTM release. If you do 
not store your new help files in the customHelp directory, the files are lost the 
next time you upgrade to a new MWTM release.

When you have created your new help files and stored them in the customHelp 
directory, enter the new help file path and file name in the Help File field.

After you deploy the new event settings and restart the MWTM server, whenever 
you display help for the status alarm, MWTM displays your new, custom help 
file.

Open Opens the help file associated with the status alarm.

To see the help file, click Open. MWTM displays context-sensitive help for the 
selected status alarm in a separate Web browser.

Action: Run Automation command or script for the status setting, to be executed by a UNIX 
process.

MWTM enables you to automate events. That is, you can configure MWTM to 
call a UNIX script to drive automatic paging or e-mail, for example, whenever 
MWTM logs an event for which you have defined an automation script.

To configure automation for an event, enter a Run line with the following format:

UNIXCommand EventParameters

where:

• UnixCommand specifies either a binary command name or a shell script.

• EventParameters are information from the event that MWTM sends to 
UnixCommand as parameters. The set of EventParameters is the same as the 
set of Message element parameters, and they are specified the same way.

After you deploy the new event settings and restart the MWTM server, the 
specified event causes the automation script to run.

Field or Button Description
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Changing User Action Events
User action events are events triggered by user actions.

To change user actions for the MWTM event database, select the turner beside Event Configuration, 
then select the turner beside User Actions in the left pane. MWTM lists the currently defined user 
actions in the left pane.

To add a user action, right-click User Actions and select Add from the right-click menu. MWTM opens 
the Add Entry Dialog, which lists the user actions that are supported by MWTM but not yet configured. 
Select a user action and click Add. MWTM adds the selected user action to the list of configured user 
actions in the left pane.

To list all settings associated with a user action, select the turner beside the user action. MWTM lists the 
currently defined settings for that user action in the left pane.

• To add a setting to a user action, right-click the user action (or one of its existing settings) and select 
Add from the right-click menu. MWTM adds a new setting to the list of settings for that user action 
and opens the Status Event Configuration panel for the new setting, which enables you to change all 
aspects of that setting.

• To delete a user action from the list of configured user actions, right-click the user action and select 
Delete from the right-click menu. MWTM deletes the selected user action from the list of configured 
user actions in the left pane.

Action: Run
(continued)

When configuring automation for events, keep in mind the following 
considerations:

• Detailed information about event automation scripts, including the times 
they start and stop and any output produced by the scripts, is recorded in the 
MWTM system event automation log file. For more information, see the 
“Viewing the MWTM System Event Automation Log” section on 
page 13-40.

• MWTM event automation scripts run separately from all other MWTM 
processing.

• If MWTM logs more than one automated event in rapid succession, MWTM 
runs each automation script sequentially, not in parallel. MWTM spawns a 
new UNIX process for each script, and waits for it to complete before 
running the next script.

• By default, MWTM allows an event automation script to run for 300 seconds 
(5 minutes) before canceling the script and moving on to the next script. To 
change the maximum run-time for event automation scripts, see the 
“Changing Event Limits” section on page 5-20.

Action: Send Trap Checkbox indicating whether MWTM is to forward the event as a trap to other 
systems:

• If you want MWTM to forward the event, select the checkbox.

• If you do not want MWTM to forward the event, clear the checkbox. This is 
the default setting.

Errors Error messages associated with the status alarm.

Field or Button Description
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• To delete a setting from a user action, right-click the setting and select Delete from the right-click 
menu. MWTM deletes the selected setting from the list of settings associated with the user action 
in the left pane.

• To change a setting, select the setting in the left pane. MWTM displays the Status Event 
Configuration panel in the right pane, which enables you to change all aspects of that setting.

The User Action Event Configuration panel contains the following fields and buttons:

Field or Button Description

Name Name of the user action, such as FileModification. You cannot change this field.

User Action Key 
and Setting

Name of the user action key, such as ModificationType, and its setting, such as 
Create.

You cannot change the name of the user action key, but you can change its setting. 
To change a user action key, select a new key from the drop-down list box. For 
example, you can change the setting for ModificationType from Create to 
OverWrite.

Category Category of the user action, such as Delete.

To change the category, select a new category from the drop-down list box.

Severity Severity of the user action, such as Normal.

To change the severity, select a new severity from the drop-down list box. The 
default severity for user actions is Normal.

Message Name User-specified message name for the event, used by MWTM for trap forwarding.

If you want MWTM to forward this event in the form of a trap to another host, 
you can specify a new, more meaningful message name for the event. The new 
message name can be from 1 to 30 characters, and can contain any letters (upper- 
or lowercase), any numbers, and any special characters. If you do not specify a 
new message name, MWTM uses the default message name, MWTM.

For more information about trap forwarding, see the “Forwarding Events as 
Traps to Other Hosts” section on page 5-35.

Message Message text associated with the user action.

To change the message text, type over the message text.

You can also insert variable text in the message. To do so, right-click in the 
message text area. MWTM displays a popup menu of the valid substitution 
variables for this event. To insert a variable in the text area, select it in the popup 
menu.
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Help File Help file associated with the user action.

By default, MWTM provides extensive type-specific help for user actions. 
However, if you prefer to provide your own enterprise-specific instructions to 
operators in the help file, MWTM enables you to do so.

To change the help file, create a new HTML help file or change the default 
MWTM help file:

• If you installed MWTM in the default directory, /opt, then the default help 
files are in the /opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• If you installed MWTM in a different directory, then the default help 
directory and files are located in that directory.

If you use an MWTM help file as a basis for your help file, rename it when you 
save it; do not use the existing MWTM name. If you do so, then the next time you 
install MWTM, MWTM overwrites the file and you lose your changes.

When you have created your new help files, store them in the 
/opt/CSCOsgm/apache/share/htdocs/customHelp directory. This directory and 
its contents are preserved when you upgrade to a new MWTM release. If you do 
not store your new help files in the customHelp directory, the files are lost the 
next time you upgrade to a new MWTM release.

When you have created your new help files and stored them in the customHelp 
directory, enter the new help file path and file name in the Help File field.

After you deploy the new event settings and restart the MWTM server, whenever 
you display help for the user action, MWTM displays your new, custom help file.

Open Opens the help file associated with the user action.

To see the help file, click Open. MWTM displays context-sensitive help for the 
selected user action in a separate Web browser.

Action: Run Automation command or script for the user action, to be executed by a UNIX 
process.

MWTM enables you to automate events. That is, you can configure MWTM to 
call a UNIX script to drive automatic paging or e-mail, for example, whenever 
MWTM logs an event for which you have defined an automation script.

To configure automation for an event, enter a Run line with the following format:

UNIXCommand EventParameters

where:

• UnixCommand specifies either a binary command name or a shell script.

• EventParameters are information from the event that MWTM sends to 
UnixCommand as parameters. The set of EventParameters is the same as the 
set of Message element parameters, and they are specified the same way.

After you deploy the new event settings and restart the MWTM server, the 
specified event causes the automation script to run.

Field or Button Description
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Forwarding Events as Traps to Other Hosts
MWTM enables you to forward MWTM events to other hosts, in the form of SNMP traps. This enables 
MWTM to integrate with high-level event- and alarm-monitoring systems such as the Cisco Info Center 
(CIC), HP OpenView, and Micromuse's Netcool suite of products. These systems can provide a single 
high-level view of all alarm monitoring in your network, making it easier to detect and resolve problems.

To forward MWTM events to other hosts, follow these steps:

Step 1 Specify the list of SNMP servers, or hosts, to which you want MWTM to forward traps. See the 
“Specifying a List of SNMP Servers for Trap Forwarding” section on page 5-22 for more information.

Step 2 Specify the events you want to forward, using one of the following procedures:

a. To forward all MWTM events, select the Send a trap for all events radio button in the SNMP 
Servers Configuration window of the MWTM Event Configurator. See the “Specifying a List of 
SNMP Servers for Trap Forwarding” section on page 5-22 for more information.

b. To forward only selected events, edit the events in the MWTM Event Configurator and select the 
Send Trap checkbox. For more information, see the description of the Send Trap field in one of the 
following sections:

– Changing Trap Events, page 5-25

– Changing Status Alarm Events, page 5-29

Action: Run
(continued)

When configuring automation for events, keep in mind the following 
considerations:

• Detailed information about event automation scripts, including the times 
they start and stop and any output produced by the scripts, is recorded in the 
MWTM system event automation log file. For more information, see the 
“Viewing the MWTM System Event Automation Log” section on 
page 13-40.

• MWTM event automation scripts run separately from all other MWTM 
processing.

• If MWTM logs more than one automated event in rapid succession, MWTM 
runs each automation script sequentially, not in parallel. MWTM spawns a 
new UNIX process for each script, and waits for it to complete before 
running the next script.

• By default, MWTM allows an event automation script to run for 300 seconds 
(5 minutes) before canceling the script and moving on to the next script. To 
change the maximum run-time for event automation scripts, see the 
“Changing Event Categories” section on page 5-23.

Action: Send Trap Checkbox indicating whether MWTM is to forward the event as a trap to other 
systems:

• If you want MWTM to forward the event, select the checkbox.

• If you do not want MWTM to forward the event, clear the checkbox. This is 
the default setting.

Errors Error messages associated with the user action.

Field or Button Description
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– Changing User Action Events, page 5-32

Step 3 (Optional) Specify new, more meaningful names for the events you want to forward. If you do not 
specify a new message name for an event, MWTM uses the default message name, MWTM. For more 
information, see the description of the Message Name field in one of the following sections:

• Changing Trap Events, page 5-25

• Changing Status Alarm Events, page 5-29

• Changing User Action Events, page 5-32

Step 4 Save your new event settings, deploy them to the MWTM server, and restart the MWTM server.

Setting Sounds for Events at an MWTM Client
MWTM enables you to create and change event sound filters for the MWTM client. Event sound filters 
determine the sounds that the MWTM client plays when specific events are logged. The MWTM client 
plays the sounds even if the Event Window is not currently displayed.

On Solaris/Linux, the root user can access the sound feature from a local or remote device. However, 
users other than the root user must use a local device, and must use a local client, not a remote 
Solaris/Linux MWTM client accessed using the xhost + UNIX command.

This section provides the following information:

• Listing Event Sound Filters, page 5-36

• Creating a New Event Sound Filter, page 5-37

• Adding a Sound File to MWTM, page 5-40

• Changing an Existing Event Sound Filter, page 5-40

• Deleting an Event Sound Filter, page 5-40

• Playing and Muting Event Sounds, page 5-40

Listing Event Sound Filters
MWTM enables you to change the list of event sound filters that the MWTM client applies to events, or 
prevent the MWTM client from playing sounds for events.

To work with the list of event sound filters, select Tools > Event Sounds from the MWTM Main Menu. 
MWTM displays the Event Sound Filters List dialog.

The Event Sound Filters List dialog lists all event sound filters that have been defined, and contains the 
following fields and buttons:

Field or Button Description

Sound filters 
applied in 
order:

Indicates the order in which sound filters are to be applied, from top to bottom. That 
is, if an event matches two or more filters in the list, the top-most filter determines 
the sound that the MWTM client plays.

This field is blank until you have created at least one new sound filter for events.

Move Up Moves the selected event sound filter up in the Sound filters applied in order: list.
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Related Topics:

• Setting Sounds for Events at an MWTM Client, page 5-36

• Working with Events, page 5-1

Creating a New Event Sound Filter
MWTM enables you to create a new event sound filter. To do so, open the Event Sound Filters List 
dialog, as described in “Listing Event Sound Filters” section on page 5-36, then click New. MWTM 
displays the Event Sound Filters dialog.

The Event Sound Filters dialog contains the following fields and buttons:

Move Down Moves the selected event sound filter down in the Sound filters applied in order: 
list.

New Opens the Event Sound Filters dialog, which enables you to create a new event sound 
filter.

Edit Opens the Event Sound Filters dialog, which enables you to change an existing event 
sound filter in the Sound filters applied in order: list.

Delete Deletes the selected event sound filter from the Sound filters applied in order: list.

Mute Sounds Checkbox indicating whether the MWTM client is to play event sounds:

• To play event sounds, clear this checkbox. This is the default setting.

• To not play event sounds, select this checkbox.

OK Applies any changes you made to the event sound filters list and closes the Event 
Sound Filters List dialog. When you are satisfied with the changes you have made to 
the event sound filters list, click OK.

Apply Applies any changes you made to the event sound filters list without closing the Event 
Sound Filters List dialog.

Cancel Closes the Event Sound Filters List dialog without applying any changes to the event 
sound filters list.

Help Displays online help for the current window.

Field or Button Description
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Button Description

Filter Name Name of the event sound filter file.

Enter a name for the filter, then specify filter criteria for this event sound filter in the 
Event Sound Filter Criteria field.

Event Sound 
Filter Criteria

Table listing the filter criteria for this event sound filter. To add a criteria, select 
options from the drop-down list boxes:

• To filter based on message text:

a. Select Message Text from the first drop-down list box.

b. Select Contains, Equals, Does Not Contain, or Does Not Equal from the 
second drop-down list box.

c. Enter the message text in the character string field.

• To filter based on event severity:

a. Select Severity from the first drop-down list box.

b. Select Equals or Does Not Equal from the second drop-down list box.

c. Select a severity, such as Normal or Error, from the third drop-down list box.the 
message text.

Event Sound 
Filter Criteria
(continued)

• To filter based on event category:

a. Select Category from the first drop-down list box.

b. Select Equals or Does Not Equal from the second drop-down list box.

c. Select a category, such as Status or Purge, from the third drop-down list box.the 
message text.

• To filter based on the name of the node associated with the event:

a. Select Node from the first drop-down list box.

b. Select Equals or Does Not Equal from the second drop-down list box.

c. Select a node from the third drop-down list box. MWTM lists all nodes that have 
been discovered in the drop-down list box.

More Adds one or more additional filter criteria to the event sound filter.

To add a filter criteria to the event sound filter, click More. MWTM adds a new 
criteria to the bottom of the list.

Fewer Removes one or more filter criteria from the event sound filter.

To remove a filter criteria from the event sound filter, click Fewer. MWTM deletes 
the last criteria in the list.
5-38
Cisco Mobile Wireless Transport Manager User Guide 5.0

OL-7637-02



 

Chapter 5      Working with Events
  Setting Sounds for Events at an MWTM Client
Related Topics:

• Listing Event Sound Filters, page 5-36

• Working with Events, page 5-1

Play this 
sound:

Drop-down list box indicating the sound to be played if an event matches this event 
sound filter.

MWTM client sound files are stored in the MWTM client’s sounds directory:

• If you installed the MWTM client for Solaris/Linux in the default directory, /opt, 
then the sound file directory is /opt/CSCOsgmClient/sounds.

• If you installed the MWTM client for Windows in the default directory, /Program 
Files, then the sound file directory is C:\Program Files\SGMClient\sounds.

• If you installed MWTM in a different directory, then the sound file directory is 
located in that directory.

To add a sound file to MWTM, add it to the sounds directory. See the “Adding a 
Sound File to MWTM” section on page 5-40 for more information.

Play Plays a sample of the sound selected in the Play this sound: drop-down list box.

OK Applies any changes you made to the event sound filter criteria and closes the Event 
Sound Filters dialog.

When you are satisfied with the changes you have made to the event sound filters, 
click OK.

Cancel Closes the Event Sound Filters dialog without applying any changes to the event 
sound filter criteria.

Help Displays online help for the current window.

Button Description
5-39
Cisco Mobile Wireless Transport Manager User Guide 5.0

OL-7637-02



 

Chapter 5      Working with Events
  Setting Sounds for Events at an MWTM Client
Adding a Sound File to MWTM
You can add sound files to an MWTM client. MWTM clients can play the following sound file formats: 
AIFC, AIFF, AU, SND, and WAV.

MWTM client sound files are stored in the MWTM client’s sounds directory:

• If you installed the MWTM client for Solaris/Linux in the default directory, /opt, then the sound file 
directory is /opt/CSCOsgmClient/sounds.

• If you installed the MWTM client for Windows in the default directory, /Program Files, then the 
sound file directory is C:\Program Files\SGMClient\sounds.

• If you installed MWTM in a different directory, then the sound file directory is located in that 
directory.

If for some reason MWTM cannot play a specified sound file, MWTM plays a default beep. For example, 
MWTM cannot play a sound file if one of the following conditions exists:

• The file has been moved or deleted from the sounds directory

• The sounds directory has been deleted or cannot be found

• Some other application is using all of the sound resources

• There is no sound card present

Related Topics:

• Creating a New Event Sound Filter, page 5-37

• Working with Events, page 5-1

Changing an Existing Event Sound Filter
MWTM enables you to change an existing event sound filter. To do so, open the Event Sound Filters List 
dialog, as described in “Listing Event Sound Filters” section on page 5-36, select the filter in the Sound 
filters applied in order: list, then click Edit. MWTM displays the Event Sound Filters dialog , 
populated with the selected filter’s settings.

Change the settings as desired, then click OK. MWTM applies your changes and closes the Event Sound 
Filters dialog.

Deleting an Event Sound Filter
MWTM enables you to delete an existing event sound filter. To do so, open the Event Sound Filters List 
dialog, as described in “Listing Event Sound Filters” section on page 5-36, select the filter in the Sound 
filters applied in order: list, then click Delete. MWTM deletes the selected filter.

Playing and Muting Event Sounds
MWTM enables you to specify whether you want the MWTM client to play event sounds. To do so, open 
the Event Sound Filters List dialog, as described in “Listing Event Sound Filters” section on page 5-36:

• To play event sounds, clear the Mute Sounds checkbox. This is the default setting.

• To not play event sounds, select the Mute Sounds checkbox.
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